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CHAPTER

In This Chapter
•	 About Custom Interface 

Design
•	 Tables of Contents
•	 Custom Menus
•	 Smart Text Objects
•	 Progress Indicators
•	 Status Indicators

Introduction
Some e-learning authoring tools have pre-made skins or players that serve as the 
navigational shell for your pages. These players allow for some customizations. Lectora, 
however, lets you create your interface from scratch—allowing you to configure every 
element exactly the way you want it.
When creating a project, you have several choices that give you maximum flexibility in 
terms of course functionality, navigation, as well as look and feel. You can:

•	 Use a course starter as-is or make changes and modifications.
•	 Use a theme as-is or make changes and modifications using style pages and/or 

style packs.
•	 Use a course framework as-is or make changes and modifications.
•	 Use a template you saved based on another project.
•	 Start with a blank project and build it yourself.

Many of the tools and features already covered in this book can help you create a 
custom interface design, such as:

•	 Changing project options  	 •  Adding images  
•	 Adding shapes and lines 	 •  Adding text boxes
•	 Adding buttons 		  •  Adding actions

In this chapter, you’ll learn about other useful tools, such as:
•	 Tables of contents		  •  Custom menus
•	 The page numbering tool	 •  Progress bars
•	 Breadcrumbs and page titles	 •  Status indicators
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Custom 
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About Custom Interface Design
Custom interface design in Lectora is based on its inheritance 
principle. If you want to have an element appear throughout 
the entire project, simply place that element at the project 
level of the Project Explorer. Or for an AICC/SCORM/xAPI 
course, place that element at the AU/A001 level. Simply 
select the project or AU from the Project Explorer before 
adding the element.

You can also have interface elements appear on only a given 
chapter, section, or page, if that’s what you have selected 
when you add the object. You can disinherit interface elements 
on given chapters, sections, or pages. For example, you may 
not want a menu on your quiz pages.

Inheritance, p. 26

Page numbering tool

Custom button

CAUTION
Be careful about what object is selected when you 
add these objects. If you accidentally add an object 
to a page when you meant to add it to the project, 
you may wonder why it doesn’t show on every page.

Interface 
elements

Image Image

Table of contents

MenuAutomatic page heading
Line

Image
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Drop-Down List
A menu appears showing the name of the current page. 
Learners click the menu, scroll through the pages (shown in 
outline form), and select the one they want to go to.

•	 This format is the most space-efficient.
•	 This format usually resides at the project/AU level.

Indented List
A scrolling text box appears showing all the pages in outline 
form. Learners scroll to find what they want and click on a 
page to go there.

•	 The list can be set up to show or hide the chapter/
section/page icons.

•	 The list can be sized small and put in the interface, or 
sized large and put on a Home page.

•	 When in the interface, this format serves as a visual 
indicator of where the learner is in the course at any 
given time, as the current page is highlighted.

Tree View
The Tree View menu is just like the Indented List menu 
with one exception: the Tree View menu lets learners expand 
and collapse chapters and sections. This is especially helpful in 
courses with long menus. 

Table of Contents Types

Tables of Contents
You can include a table of contents (TOC) with your project to let learners navigate around the course. Each of the 
three format options (shown below) are automatically populated and updated based on the structure and names in 
the Project Explorer. All items in the TOC are hyperlinks that, when clicked, take the learner to that page. 

TIME SAVER
Even if you don’t want your learner to have a table 
of contents, you may want one temporarily for 
review cycles, making it easier for reviewers and 
developers to navigate the course. For the final 
publish, simply remove it.
You could also add a small, transparent button that 
shows a text entry box for a password, which, if 
entered correctly, shows the table of contents.

Actions, ch. 8 
Adv. Actions, ch. 9

Tree view

Indented list

Drop-down list

ACCESSIBILITY
Menus and tables of contents make your courses 
more accessible. Giving a learner more than one 
way to navigate provides valuable flexibility.
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To add a table of contents:
1.	 Select the location where you want the TOC 

(project, AU, chapter, section, or page).
2.	 Go to the Insert tab.
3.	 Click the Table of Contents drop-down button.
4.	 Select the type you want.
5.	 Adjust the placement and size.
6.	 Configure the properties. (See below.)

Add a Table of Contents

Scope
If your table of contents is somewhere other than the project 
level, use this menu to indicate what part of the project to include. 
For example, a chapter-level TOC might only display the pages in 
that chapter, rather than all the pages in the project.

Frame
If you are using frames in your project, you can put the TOC in 
one frame to navigate the pages in another frame. Use this menu 
to select which frame the TOC should refer to.

Frames, p. 24

Included Pages
Click this button for a dialog box to designate any pages that 
you don’t want to have appear in the TOC, such as a final quiz or 
pages used for pop-up windows. Click the gray box next to a page 
(A) to leave it out of the TOC. Click it again to put it back in.

Show Pages
For drop-down or indented TOC styles, you can uncheck this 
box if you only want chapter and section levels to appear. 
Individual pages will not be shown.

Type
From this menu, you can change the type of TOC.

Frameless
When publishing to the web, you can check this box to have a 
transparent background on the TOC. 

Use Icons
For indented and tree TOC types, you can uncheck this box if you 
don’t want to show the icons for chapters, sections, and pages and 
only want to show the names.

Table of Contents Properties

A
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Custom Menus
Custom menus are a great way to add streamlined navigational options to your projects. Many project templates 
(like the one shown below) use a vertical menu to provide navigation to the different chapters. Horizontal menus 
are useful for special course features and utilities, such as Help, FAQs, and Resources. Both horizontal and vertical 
menus can have separator lines as well as submenus that appear when the learner clicks the associated main menu 
item. Submenus can have their  
own submenus as well. 
Tables of contents pull from 
your project structure and 
navigate to pages. However, 
each menu item can have its 
own action, such as going to 
a chapter or page, bringing 
up a pop-up window, 
launching a document, etc.

To add a custom menu:
1.	 Go to the Insert tab.
2.	 Click the Menu button.
3.	 Select a menu item from the list. (A)
4.	 In the Name field at the top, name the 

menu item. 
5.	 In the Menu Item Action section, set 

up the action for that menu item. 
6.	 Repeat steps 3—5 for the additional 

menu items.
7.	 Format the menu and submenus on the 

two style tabs. (See next page.)
8.	 Click the OK button.

Actions, ch. 8

Menu Configuration Options
•	 If you want more than three menu 

items, click the Add Item button.
•	 Delete a menu item by selecting it from 

the list and clicking the Delete button.
•	 Click the Add Separator button to put 

a line between menu items.
•	 Use the up and down arrow buttons to 

change the order of the menu items.
•	 Use the left and right arrow buttons to 

indent items, which creates submenus.
•	 Check the Create Menu from table 

of contents check box to create menus 
and submenus out of the chapters and 
sections in your course.

Add a Custom Menu

A

Menu created from the table of contents

Vertical menu

Horizontal menu with submenu
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Menu/Submenu Style 
The menu can be formatted from the Menu Style and 
Submenu Style tabs in the Menu Creator or later from 
the same tabs in the main interface. 
The first button is different on the menu and submenu tabs, 
but the rest of the options are the same.  

•	 Orientation: On the Menu Style tab, use the first 
button to indicate if you want a horizontal or vertical 
menu. 

•	 Set Submenu Style: On the Submenu Style tab, 
the first button, by default, is Set Submenu Style, 
which means that the submenu can have different 
formatting than the main menu. If you click this button, 
it becomes Use Menu, meaning that the submenu will 
use the same formatting as the main menu. When this 
option is chosen, the formatting options on this tab 
are locked. Use this button to toggle back and forth 
between the two settings. 

Many of the formatting options you’ll see on the style tabs 
are the same options you’ve learned about in previous 
chapters, such as text formatting. Here are some of the 
options unique to menus:

•	 Rollover (Text Style Section): Select a different 
color for the text when the learner’s mouse hovers over 
that item.

•	 Fit to Text: Adjust the size of the menu based on the 
amount of text you have.

•	 Margin: Indicate how much extra space you want 
around the text of the individual menu items.

•	 Menu Image: Use this drop-down menu to select an 
image to serve as the background for the menu.

•	 Menu Color: Change the color of the menu 
background.

•	 Rollover Color: Change the color of the menu 
background when the learner’s mouse rolls over it.

•	 Frame/Outline: Select an outline style for the menu 
items.

•	 Separator Color: Select a color for any separators 
you added between menu items.

•	 Outline Color: Select a color for the outline, if you 
added an outline.

Add a Custom Menu (cont’d)

POWER TIP
When you are setting up the logic for 
your menu and submenu items, you can 
only add one action per item. If you’d like 
a menu item to activate more than one 
action, set them up as an action group, 
and use the menu to trigger the group.

Action Groups, p. 147
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If you’ve taken the time to name all of your 
chapters, sections, and pages in the Project 
Explorer, you don’t need to re-type all of that 
information on each page. Instead, you can 
add automated text boxes at the project level 
that automatically populate each page with that 
information.
Breadcrumbs tell your learners where they are 
in the course, showing the chapter, section, 
and page name. The page title option shows 
only the page name. Note that both options are 
display-only and are not live hyperlinks.

To add breadcrumbs:
1.	 Go to the Insert tab.
2.	 Click the Breadcrumb button.

To add an automatic page heading:
1.	 Go to the Insert tab.
2.	 Click the Page Title button.

Add Breadcrumbs and a Page Title

BRIGHT IDEA
These text boxes are set to be initially hidden. 
They come with actions that set the contents 
of the text box, followed by an action that 
then shows the text box. This is so the learner 
doesn’t see the placeholder text for a split 
second while the page is loading.

Breadcrumbs and page title in Run mode

Breadcrumbs and page title in Edit mode

Breadcrumbs and page title in the Project Explorer

You can add a dynamic text box that automatically 
updates with the current date and/or time, based 
on the learner’s system date and time. This can 
be either added as part of your interface or on a 
content page.

To add the date and time:
1.	 Go to the Insert tab.
2.	 Click the Date/Time button.

To add the date or the time:
1.	 Go to the Insert tab.
2.	 Click the Date/Time drop-down arrow.
3.	 Select Date or Time.

Add Date and Time

Automated date/time

Smart Text Objects
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The page numbering tool adds page numbers to your 
course without having to do it manually. You can set 
it up to number the entire project, start over at every 
chapter, start over at every section, etc.

To add page numbers:
1.	 Go to the Insert tab.
2.	 Click the Page Number button.
3.	 From the Scope drop-down menu, indicate if 

you want to number all pages in the project 
sequentially or if you want to start the numbering 
over with each chapter or each section. 

4.	 Check or uncheck the box to indicate if you want 
to include the total number of pages (n of nn).

5.	 From the Page drop-down menu, select the text 
you want at the beginning of the text string: 
Page, #, or nothing.

6.	 In the of drop-down menu, select of or / to 
delineate the page number from the total number 
of pages (if you selected that option).

7.	 In the Font and Color section, select either a 
text style to use or set your formatting with the 
individual formatting options.

8.	 Click the OK button. 

Add Page Numbers

POWER TIP
You can further customize the page numbering by 
going into the advanced action used to create it. 
It is common to need to change the total number of 
pages in your project. For example, you might have a 
chapter with pop-up pages that shouldn’t be included 
in the page count. You can go into the action and 
change VAR (PagesInTitle) to the exact number 
you want. (You’ll need to manually update this any 
time the number of pages changes.)

page counter as it appears in the Project Explorer

DESIGN TIP
Make sure your text box has enough room 
for your largest page number. A text box that 
can handle 1 of 11 may not be big enough 
for one that needs to say 39 of 39. 
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To add a progress bar:
1.	 Go to the Insert tab.
2.	 Click the Progress Bar button.
3.	 Go to the Properties tab for the progress bar.
4.	 From the Orientation menu, select 

Horizontal or Vertical.
5.	 In the Type menu, select one of the three 

types of progress bar.
6.	 Configure the rest of the settings as 

described below.

Add a Progress Bar

Table of contents 
progress bar

Custom 
progress bar

Progress bar with tick marks

Progress bar with custom image

Progress Indicators
You can pick from three types of progress bars 
that have a variety of uses. Two of them work 
automatically, and the third progresses based on 
actions you set up. 

•	 Timer progress bars count down or up automatically 
based on the amount of time you set and can be 
used to add a “beat-the-clock” element to games and 
quizzes. 

•	 Table of Contents progress bars automatically show learners 
their progress through a given course, chapter, or section, 
based on how many pages they’ve completed.

•	 Custom progress bars move forward based on actions you 
set up. For example, you could set up a progress bar to move 
based on how many points the learner scores in a game. 

Properties for All Progress Bar Types

Default Image: By default, a progress bar is filled with small, 
green rectangles. You can use this menu to select a different 
image to fill the bar, or you can select No Image.  If you 
select No Image, the Fill color drop-down button activates so 
you can pick a solid color to fill the progress bar.
Tick Marks: Check this box if you want to include tick marks 
along the bar.
Empty Bar: By default, the bar starts empty and fills up as 
the progress bar continues. Check this box if you want the bar 
to start full and then empty as the bar progresses.

Additional options for color, border, position, etc. are the same 
as for any object.
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Progress Bars (cont’d)
Properties Specific to a Timer Progress Bar

Total Time: Indicate the number of seconds for the timer.
Increment: Indicate how often (in seconds) the timer updates.
Auto Start: By default, the timer does not start when it first loads (meaning you’ll need a Start action to start it). 
Check this box if you want it to start automatically.

Properties Specific to a Table of Contents Progress Bar

Scope: Use the drop-down menu to indicate if you want to include the entire project, just a given chapter, etc. The 
options on the menu vary based on what object (project, AU, chapter, page) the progress bar is attached to.
Frame: If you are using frames, indicate which frame’s content you want to use for the table of content’s progress.
Included Pages: Click the button to indicate which pages should be included in the progress calculations.

Properties Specific to a Custom Progress Bar

Range: Indicate how many increments you want in the progress bar. For example, a game has 10 possible points.
Step Size: Indicate how many increments the bar will move each time you have the bar move a step up or down. 
For example, in the game, it might move 2 points up or down per question.
Variable: You can select a variable where you store the value of the progress bar. 
Initial Value: Set the starting increment for the progress bar.
Retain Value: Check this box if you want to save the position of the progress bar between the learner’s sessions.

Actions for Moving a Custom Progress Bar
Remember that custom progress bars don’t move on their 
own like the other two types. Therefore, you need to create 
the actions to move it up or down. There are two choices.
Step Progress Bar Position: When you run this action, 
the progress bar moves forward or backward by the 
increment you entered in the Step Size field. 
Set Progress Bar Position: With this action, you set the 
value of the bar to a specific number. 
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To add a pre-made status indicator 
from the Stock Library:

1.	 Go to the Insert tab.
2.	 Click the Status Indicator drop-

down menu.
3.	 Select Stock Status Indicator.
4.	 From the Media Library, double-

click the status indicator that you 
want.

5.	 Go to the Properties tab.
6.	 In the Target field, select the 

portion of the course you want  
to base the status on.

Add a Stock Status Indicator

Status Indicators
Lectora automatically tracks whether learners have visited or completed 
chapters, sections, pages, tests, and surveys. You can use this status to create 
if/then logic, such as conditional branching or unlocking sections based on a 
learner’s progress. You can also show this status to the learners by adding them 
to chapters, sections, pages, or even tables of contents. These status indicators 
can come from the media library, or you can use your own images.
The tracking status can be in one of these three states:

•	 Not Started (default): When referring to the page, the page has not 
been viewed. When referring to a chapter, section, test, test section or 
survey, no pages have been viewed or accessed. 

•	 In-Progress: At least one page in the chapter, section, test, test section, 
or survey has been viewed, but not all of them have.

•	 Completed: When referring to the page, the page has been viewed. 
When referring to a chapter, section, test, test section or survey, all pages 
have been viewed or accessed. 

Lectora Online Lectora Desktop

DESIGN TIP
•	 Each stock status indicator 

automatically comes with all 
three states. The preview in the 
Media Library shows you the 
Completed state.

•	 You can change the images used for a 
status indicator. Go to the Properties 
tab, and click the pencil icon for the 
status option you want to change.
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To add a custom status indicator:
1.	 Go to the Insert tab.
2.	 Click the Status Indicator menu.
3.	 Select Custom Status Indictor. 
4.	 For each state (Completed, Not Started, and 

In Progress), click the menu.
5.	 Select an image from the list or click Browse 

for File to find and select an image.
6.	 Repeat steps 4 and 5 for the other status 

options.
7.	 Click the OK button.
8.	 Go to the Properties tab.
9.	 In the Target menu, select the portion of the 

course you want the status indicator to be 
based on.

Add a Custom Status Indicator
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Add a Status Indicator to a Table of Contents

For menus created from a table of contents, you can 
display status indicators for the tracking status of 
chapters, sections, tests, test sections, and surveys. 
This is a great way to show learners their progress in 
the course.

To add status indicators to a menu:
1.	 Select the menu. 
2.	 Go to the Properties tab. 
3.	 Specify the images for the Completed, In 

Progress, and Not Started fields.

Add a Status Indicator to a Menu

Status indicators can also be added to tables of contents 
using Tree View or Indented View. (It is not available for 
Drop-down List.)

1.	 Select the table of contents.
2.	 Go to the Properties tab.
3.	 Specify the images for the Completed, In Progress, 

and Not Started fields.

Custom Menus, p. 168

Table of Contents, p. 166

TIME SAVER
You can add status indicators when you first create 
the menu. Once you set the menu to be based on the 
table of contents, the status indicator options appear 
on the Menu Item tab. 
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Set the Tracking Status of an Indicator
You can override the status for a specific chapter, 
section, or page using the Set Tracking Status 
action.

To set the tracking status of an indicator:
1.	 Add an action to the object you want to use to 

set the status.
2.	 Go to the Action tab.
3.	 Click the action drop-down button.
4.	 Select Set Tracking Status.
5.	 In the Target drop-down menu that appears, 

select the chapter, page, etc. you want to set.
6.	 In the Status menu, select the status you want 

to set.
7.	 Set a condition for the action, if you want one.

Conditional actions, p. 156

POWER TIPS
•	 Why might you want to manually set status instead of 

using the learner’s actual status? A common reason is 
to use the status indicators as badges in a game. You 
can add a custom status indicator to your project, and 
then associate it to a certain chapter or page in the 
Target field of its properties. Then, when the learner 
meets the requirements to earn the badge, you can 
manually set the target to be complete.

•	 You can also use the status of a chapter, page, etc. as 
a condition. As you set up a condition on an action, 
go to the Variable drop-down menu, and select 
<Chapter/Section/Page>. From there, you can 
select the chapter, section, or page you want, and 
then select the status in the Relationship column.

  

CAUTION
•	 If you manually set a chapter, section 

or test to Not Started, then all 
sections, sub-sections, and pages 
under it will also be set to Not 
Started.

•	 If you manually set a chapter, page, 
etc., to In Progress, it loses the 
ability to automatically set itself to 
Completed. If you want it to later 
be set to Completed, you’ll need to 
create another action to make that 
happen. 

•	 Graded tests cannot be the target of 
a Set Tracking Status action. They 
are automatically set to Completed 
when they are passed. Until then, they 
remain Not Started or In Progress, 
as appropriate.

•	 By default, status is retained between 
sessions. This can be turned off in 
Options by unchecking Retain 
Tracking Status Between 
Sessions.
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